


©
2
0
0
3
 B

er
n

in
a
 o

f 
A

m
er

ic
a

November 10 through December 31, you’ll also receive a free gift with select purchases

at your Bernina Dealer. Plus, visit berninausa.com to see the holiday catalog and enter

the exciting sweepstakes––you could win a $5,000 Bernina shopping spree!

So, hop in your holiday sleigh and hurry in to your Bernina Dealer today. 

No one supports the creative sewer like a Bernina Dealer. • www.berninausa.com

*At participating dealers

Special financing, great prices* and a sweepstakes, too! 
Come in to Bernina, there’s something for you!
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WHO
We Are...

Carrie started embroidering at age 12 after
spotting an old box in someone's trash. She
opened it to find ribbon and silk threads with
labels from the early 1900's. Since then she has
become a weaver, scrapbooker, quilter and
spinner of yarns both literal and figurative.

KAY
LYNCH
“Sew
Welcome”

CARRIE
GORR
Snap, Stitch 
& Scrap

As an Education Consultant for BERNINA® of
America, Jill is the resident master of stitch
manipulation. She loves playing with them,
changing them, and using them to create
textured fabrics for garment and craft projects.

Currently stitching a collection of purses and
totebags, Jo is constantly on the lookout for
quick, simple projects to share with beginning
seamsters. As Editor for BERNINA® of America,
Jo is instrumental in the production of Through
the Needle.

A mom, grandma, nurse, and former National
Guardswoman Laurie has been sewing since she
was 10 years old. She bought a used BERNINA®

1130 in 1988 and has been a loyal fan ever since.
She loves to “think outside the box” and develop
unique stitched creations. The newest addition to
her all-BERNINA® household is the version 4
artista embroidery software.

Jennifer, an Education Consultant for
BERNINA® of America, combines serging,
sewing, and embroidery in many of her
updated interpretations of favorite patterns,
many of which incorporate decorative serger
techniques in unexpected places.

As a Card Production Assistant at OESD, Inc.,
Kay’s job is to assist in the development of
designs and embroidery cards for BERNINA®

and OESD, and to create projects using the
embroidery designs. She has a BS degree in
Home Economics Education from Oklahoma
State University.      

GAYLE 
HILLERT
BERNINA®

News;
Journey
Through Life

JO
LEICHTE
Managing
Editor; 
Snap, Stitch 
& Scrap; Hat
Hoop Insert

After a career as a CPA and homesteader/
innkeeper and having sent her youngest off to
college this fall, Annie appreciates having time to
indulge her loves of quilting, scrapbooking, and
playing on the computer. Annie has recently
posted a website (www.byannie.com) which
showcases her line of patterns for quilters and
fabric lovers.

ANNIE
UNREIN
There’s No
Ship Like
Friendship

An avid sewer since she was a young girl, Gayle
has managed to combine her vocation and her
avocation. As Vice President of Education for
BERNINA® of America, Inc. she is responsible for
training, education and   testing functions relating
to all BERNINA® products.

SUSAN
BECK
Chief Editor;
Rows of
Quilting

With a background in Art and Home Economics,
Susan is interested in all types of sewing and
crafts and has written several sewing books. She
loves to be creative on paper as well as in fabric
and is the Director of Education for BERNINA® of
America, Inc.

SUSAN
FEARS
BERNINA®

Fashion:
Black Rose
Blouse

MARTHA
SHERRIF
Explorations
Software

SANDRA
BETZINA
Asian
Styling

LAURIE
THOMAS
Count the
Days

JILL
DANKLEFSEN
Stitch Recipe:
Stars & 
Stripes

JENNIFER
GIGAS
Taste of
Technology
Quilt

Sandra is the dynamic host of HGTV's Sew
Perfect, and the author of Fabric Savvy, Fast Fit,
and the Power Sewing series of books and
videos, as well as the syndicated Power Sewing
column. She travels all over the United States and
Canada as a lecturer, teacher, and guest on
television sewing shows. 

Susan enjoys all types of sewing, especially
garment making. She got hooked on quilting
while making a quilted jacket, and now enjoys
quilts throughout her home. She finds inspiration
everywhere, especially through her travels as an
Educator for BERNINA® of America.

MARLEE
CARTER
Fantastic
Felines Vest

Marlee has been sewing since junior high school,
and enjoys both quilting and garment sewing. Her
first quilts were traditional, but now she creates
mostly art quilts and art-to-wear. She dyes and
paints her own fabrics and applies sewing
techniques in unusual ways. She teaches classes
at her local BERNINA® store, Cote Brothers, in
Auburn, Maine.

After taking a class in freemotion embroidery
at the local BERNINA® store, Martha spent
many hours “coloring” at her sewing machine
She and her sister, Mary, created their own
embroidery business, Uniquely Yours, which
later grew to be OESD, where Martha is
Director of Marketing Support. 

GAYLE
CAMARGO
Meadowbrook
Table
Medallion

Gayle Camargo has been in the quilting industry
for over 30 years, as a quilter, teacher and designer.
As Director of Creative Merchandising for
Benartex, she is responsible for all the packaging
and displays that Benartex has become known
for. She and her husband Robert live in a colonial
cottage built in 1750 in Westport, Massachusetts.
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BY GAYLE HILLERT

Fall is such an exciting time for sewers. Projects for holidays
and gift-giving dance through our heads, the nights grow

longer and colder—so time in front of our sewing and embroidery
systems is sometimes easier to arrange, and new products and
projects are easily found in magazines, web articles and in
dealers’ classes. This issue of Through the Needle is no
exception, with plenty of ideas for inspiration and implementation.

BERNINA® of America has sponsored
the BERNINA® Fashion Show for three

years and it is hard to conceive that the
garments can get more beautiful—

but they do. The theme of this
year’s Fashion Show is “Fantasy”
and the designers have turned
the fantasies that live in their
thoughts and dreams into reality

with 49 exquisite masterpieces of

creativity. One need only to
gaze at the details – the stitching, the
piping, the embroidery, the ribbons
and embellishments – to imagine the
thought, love and time that goes
into the creation of each one. We

pay homage to the designers by telling you about the
BERNINA® Fashion Show and a little about the creators who
stitch these fantasies.

A new accessory for BERNINA®

is the Hat Hoop Insert by
Hoop ‘N’ Buddyz that
allows you to embroider
a hat with ease – the
perfect gift for your
husband or son.
Another new product
helps create a great
professional finish
when serging – our
new Cover Stitch
Hem Guide.

How many of you
enjoy putting your
photos into a memory
album? How many of you have
your precious memories laying in a
drawer waiting to be mounted into an album?
Have you ever thought about combining your love of sewing with
the preservation of your photo memories? The article on page 12
shows you how to combine a little bit of sewing with a little bit of
scrap booking for an exciting combination of cloth and threads
with paper and glue!

This issue of Through the Needle offers something for
everyone—those of you who have set aside lots of time to sew for
the fall and holidays, and those of you who have little time, but
still want to make something special very quickly.

Enjoy each article as we have enjoyed developing them for your
pleasure and creative stimulation!

Have a wonderful fall and a very memorable holiday season.
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“A Florida Fantasy… 
Changing Seasons” 
by Toni Carroll

“My Hydrangea Habit” 
by Jennifer Amor
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BY SANDRA BETZINA

Asian styling has become a classic because it is both elegant and comfortable and – depending on the style – can
hide figure liabilities. My two favorite Asian-influenced patterns are Vogue 7263 and Vogue 7747, which I designed

for Vogue Patterns under the Today’s Fit label. 

Vogue 7263 can be worn as a blouse or a lightweight jacket. It can be made in cotton, linen, rayon
or silk. The style is very fabric-friendly, which means it can be made successfully in

virtually any    fabric. It is also figure-friendly since it can be worn by ALL body types.
The pattern shows how to make your own button and loop closures, but if you are

time-poor, simply buy some great looking frogs and leave it at that. The narrow leg,
pull-on pant in this pattern was designed for a knit, but can be made in a woven

by simply adding 1/2” to each side seam, returning the two inches of ease back
into the pants. No other pattern changes are needed.

Vogue 7747 is the classic cheongsam style, redesigned so that it can be worn
by both perfect and not-so-perfect figures. This dress features front and back

vertical waistline darts which can be increased in width for a closer fit, or
decreased in width – or eliminated entirely – for a looser fit. I suggest basting

the darts and trying on the dress before making that decision. While this style is
shown as a dress or tunic, it also makes a terrific top; simply measure 23” straight

down from the center back neckline and cut off the bottom of the pattern at this
point. This pattern makes up beautifully in silk crepe de chine, silk dupioni, or any
crepe weave. Recently I have found some beautiful polyester crepes in Asian-inspired
prints like those shown in the photos. These fabrics come from Japan and the name
NAOMI ITAYA is printed on the selvage. These crepes are unlike any I have ever

worked on – they sew and feel like some of the crepes our mothers wore and they
NEVER wrinkle. Preshrink these crepe weaves by soaking in a basin of warm water,
then dry in a low heat dryer. Sew both the crepes and the silks with a brand new size
70/10 Microtex Sharp (H-M) or Jeans/Denim (H-J) needle. For pucker-free seams,
support the fabric around the needle with a straight stitch presser foot (such as
BERNINA®’s Straight Stitch Foot #13 or Patchwork Foot #37) and a straight stitch
throat plate. If these options are not available to you, use an all-purpose presser foot
and move the needle to the far left to give the fabric support on three sides. 

Asian styles are usually worn with narrow pants which end just above the ankle or slim
straight skirts which peg slightly at the sides such as Vogue 7333. Since the styling

itself is so attractive, keep accessories to a minimum, letting the frog closures do the
talking. I like to highlight the mandarin collar and asymmetrical seams with piping to

show off the style lines. On Vogue 7263, using a contrasting fabric for the front placket
provides a nice vertical line and is very slimming, especially if the contrast fabric matches

the pants or skirt. What will you wear on your feet? These styles look well with a simple mule,
Chinese slippers, a low heel, pointed toe boot, or a Mary Jane shoe with a strap. 

What outerwear works over Asian styling? Unless you own a long, vintage kimono, my favorite is a
very simple wrap which can be made with two yards of 58-60” wide fabric. Wool jersey or other drapey
fabrics are the best choices for this wrap. Because of the amount of fabric at the back of this wrap, choose
a fabric which drapes but is not bulky. Purchase an additional 1/4 yard of a contrasting knit to use for
the binding. 
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DIRECTIONS:

1. Fold the two yard length of fabric in half crosswise, right sides together, so that the
selvages match. On each end, sew a seam joining the two selvages. 

2. Along the folded edge, 6” from the seam at each end, cut two slits along the fold,
creating two 12” armholes. 

3. In the middle,
starting at one cut
edge of the fabric
and parallel with
the sewn seams,
cut a slit 17” long

– through one fabric
thickness only – to create
the center front opening. 

4. From the contrast fabric,
cut a strip 4” wide and 18”
long. Fold under the raw edges 1/2” on all sides; press. On the wrong side of the fabric (the
side where the seam allowances are visible on each end), 2” above the 17” center front slit,
overlay the wrong side of the strip onto the wrong side of the fabric, just above and in line
with the center front slit. Topstitch     the long sides of the strip onto the fabric. Do not sew
short ends of the strip. To create dramatic folds when the wrap is worn, create a drawstring

casing by sewing two  additional rows of stitching lengthwise, parallel to and 1/2”
away from the stitching on the sides of the lengthwise strip. 

5. Make an 18” long fabric tube; insert into one open end channel of the strip. Pull
through to the other
end, then insert into
the second channel
and pull through so
that both ends of
the tube are at the
same end. Draw
the fabric up as
tightly as possible,
then tie the ends of
the tubing securely
together. 

6. At the lower front edges, round off the corners. 

7. Finish all raw edges, including armholes, with contrast binding. 

Slip the jacket on, letting the drawstring placket fall to the back, and placing
hands through the armholes.
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Resources:
NAOMI ITAYA polyester crepe: Available at www.itaya-naomi.com
Today’s Fit patterns - available where Vogue patterns are sold.
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Please read through all instructions before beginning your
project. Refer to your BERNINA® artista Embroidery Software
V4.0 User Manual as needed.

Download this holiday
frame design from the Free
Download section of
www.berninausa.com. It’s
perfect for holiday quilt
labels, embroidered gift
tags or for little ones
counting down the days
until Christmas.

This design can also be downloaded from the Fons and Porter
website at www.fonsandporter/tv/candylabel.html.

STEP 1
Select File>New.

Right click on the hoop icon. Select large or large oval hoop,
rotated. Select manual placement. Click OK.

STEP 2
Select File>Insert Design.
The entire design will be
selected when it opens on
screen; group it. Right click
to open the Object
Properties dialog box. From
the General tab, change the

dimensions to 90% both in width and height. Click OK.

Move the grouped design to the far right and slightly above the
center of the hoop as shown in the diagram.

STEP 3
Select the Rectangle tool;
select Outline>Single and
Color C2 from the Stitch and
Color bar.

Draw a rectangle, centering it
over the frame.

Select the rectangle;
duplicate it. While the
duplicate is selected,

change its color to C5 from the Stitch and Color bar. Note:
These two rows of straight stitching become the appliqué
placement and tack down lines.

STEP 4
Open Color Film; hold down the Ctrl key on the keyboard and
select the last two colors on the filmstrip (the two rectangles).
Drag the selected colors to the beginning of the filmstrip to
re-sequence the stitching order.

STEP 5
Press the A key on
the keyboard to open
Lettering Properties.

Select the Child’s Play
alphabet; type DAYS
TILL CHRISTMAS in the
text box. Press OK.

Click on the design screen to generate lettering. While lettering
is still selected, use one of the corner sizing handles to rescale
the lettering to fit the scale of the project. Change lettering
color to C2.

STEP 6
Select File>Insert Design. Select a holiday design from your My
Designs folder or import a design from your favorite holiday
collection (Santa design shown on the next page is from the
Studio BERNINA® Ingrid’s Christmas embroidery collection).

While the design in still selected, group it. Move it to the left
side of the hoop and position as desired.

Adjust placement of lettering if needed.

STEP 7
Select the frame; ungroup it. Select the holiday design;
ungroup it.

Select All. Select Arrange>Sequence by Color; click OK. This
will combine the duplicate colors in the design.

Select All; rotate 90˚.

Select File>Save As. When the save dialog box opens, name
your design and store it in your My Designs folder.

Send the design to the machine, Personal Design Card, or
Magic Card.

BY LAURIE THOMAS

Embroidery Preparation
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SUPPLIES:
• Embroidery machine 

• Background fabric, 12” X 10” 

• Chalk board fabric, 4 “X 5” 

• Border fabric, 1/4 yard, cut into two 
11/2” strips

• Binding fabric for about 40” of 
binding strips

• Backing fabric, 11” x 8”

• Lightweight batting, 11” x 8”

• Cut-Away stabilizer 

• Patchwork Foot #37

• Walking Foot #50 (optional)

• Edgestitch Foot #10/10C

• Desired Christmas design

STITCH EMBROIDERY

STEP 1
Spray Cut-Away stabilizer with temporary fabric adhesive; adhere
to back of 12” x 10” rectangle of fabric. Hoop fabric/stabilizer as
one unit in large hoop.

STEP 2
Stitch Color 1 (the placement line). Spray wrong side of 4” x 5”
chalkboard fabric with temporary fabric adhesive; position over
placement line and finger press in place. Stitch Color 2 (applique
tack down). Carefully remove the hoop from the embroidery
machine/module and trim excess fabric from outside the stitching
line. Carefully reattach hoop to the embroidery machine/module. 

STEP 3
Embroider the rest of the design. Remove hoop from
machine/module and fabric from hoop. Do not trim away stabilizer,
as it provides stability to the panel. Trim rectangle to 10” x 7”,
centering the embroidery.

ATTACH BORDERS

STEP 4
Cut two 11/2” x 10” strips from border fabric; stitch to upper and
lower edges of embroidered panel using Patchwork Foot #37 and
a 1/4” seam allowance. Trim and press seams toward borders. 

STEP 5
Cut two 11/2” x 81/2” border strips. Cut a strip of border fabric 11/2” x
10” for the chalk pocket. Fold it in half to form a 11/2” x 5” rectangle
with the fold at the upper edge. Place pocket on one side border
strip, matching raw edges at sides and lower edge; pin together.
Treating this as one piece, stitch this border strip to the right edge
of the panel, making sure that the pocket is at the bottom of the side
border. Stitch the remaining border strip to the left side of the panel. 

FINISH QUILT

STEP 6
Optional: Stitch a message on the backing fabric, i.e. Love,
Grandma; Merry Christmas 2003; Will Christmas Never Come?;
etc. if desired. Optional: Add a sleeve to the backing fabric at
this time.

STEP 7
Layer quilt: backing right side down, batting in the middle,
embroidered panel right side up. Baste layers together using
temporary fabric adhesive. Using Walking Foot #50 or Edgestitch
Foot #10/#10C, machine quilt in-the-ditch along inner edges
of borders. 

STEP 8
Attach binding using your favorite binding method. Have a child
that’s eagerly anticipating Christmas, record the number of days on
the chalk board fabric daily. Store chalk in the pocket on the right
border as shown. 

Construction
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S
ometimes we get so busy living life that we forget about the
really important things—ourselves, for example. Six and a
half years ago, I sat in a doctor’s office and heard the words

that no woman expects to hear. I was diagnosed with a very rare
form of breast cancer and I was going to have to undergo a
mastectomy in a matter of days.

It was at that time that I realized none of us really have control of
our lives. I happen to be a very organized person—I start each
day with goals and I try to accomplish those goals before putting
my head on a pillow at the end of the day. I have a place for
everything and everything is in its place. I have a family that I
think listens to my directives and tries to respond. I am Vice
President of Education and Training for BERNINA® of America
and juggle many balls in the air. I have a group of people that I
give direction to—and I was under the silly assumption that I was
in control of my life and that I did not have the time to be sick.

I had no family history of cancer, I was not in the
average age group for breast cancer and I did not
possess any of the indicators for acquiring breast
cancer. But it did happen and when I heard
those words from the doctor, I realized that none
of us is safe. However, the next words out of his
mouth were the words I chose to listen to and the
words I tell everyone who asks about the disease. His
next words were, “In this day and age, we cure breast
cancer.”

Breast cancer is an epidemic. And although I was very naive
about breast cancer and chemotherapy treatments six and a half
years ago, I have learned what it is all about. I learned that breast
cancer is so prevalent in our society that it touches everyone in
one way or another—a mother, a daughter, a best friend, an
acquaintance…the list is too long. I learned that it is a battle to
be won, that you can discover significant things along the way
and I learned about the optimism of the human spirit, the
kindness of those around me, the power of a positive attitude and
the calming affects of prayer and support from others.

The human body is a wondrous mechanism. An errant cell can
go out of control and affect the body in a life-threatening way. The
human body can withstand treatments of toxic chemicals that
weaken the system, destroying the good with the bad, make one
lose one’s hair, be nauseous and disoriented, yet recover enough
for the next treatment, and the next and the next.

The worse thing to do is to question why breast cancer
happens—you will never get an answer. It just happens. It selects
rich and poor, famous people as well as non-famous, young and
old, thin and not so thin, happy and unhappy, busy people with
stressful lives as well as those who lead more leisurely lifestyles.

In life, things happen that can sadden and beat the spirit—it is
how you react to those circumstances that charts the course in
your journey through life. Breast cancer is just a bump in the
road. I was designing a pin for BERNINA® to sell at quilt festivals
when I learned I had breast cancer. Then I began reading and
found out how many women were affected and I read about the
organizations conducting research to try to rid the world of can-
cer. The heart-shaped pin that I was designing became a heart-
shaped pin with a pink ribbon. BERNINA® sells these pins to raise
money; thousands of dollars have been donated to the Susan G.
Komen Foundation to help fund research for the eradication of
breast cancer.

The year I was diagnosed, Martin Favre, president of BERNINA® of
America, announced that proceeds from the sale of every

top-of-the-line machine would go to the Susan G. Komen
Foundation. The next year BERNINA® of America

started a yearly tradition of hosting a Cure Cancer
Walk/Run at its annual dealer convention. Money
raised from our walks along the California beaches in
Long Beach and Monterey, in a park in Kansas City, in

downtown Washington D.C., and in 90 plus degree heat
in Dallas, Texas has been donated to the Susan G. Komen

Foundation. All in all, BERNINA® of America has donated over
$450,000 to fund the search for the cure of breast cancer.

BY GAYLE HILLERT
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I chose to continue working full time after being diagnosed, after
having the mastectomy and during the chemotherapy
treatments. It was my way of battling the circumstances and
clinging to what I still controlled while watching helplessly as my
hair, eyebrows and eyelashes fell out and my body weakened. I
also chose to wear hats. At our annual dealer convention, when I
walked to the stage to deliver my speech during opening ses-
sion, I looked out into the audience of 1000 and many of the
attendees were wearing hats in support of my predicament. I will
never forget that sight and never forget the cloud of comfort and
support I felt surrounding me.

BERNINA® is a good company filled with good people. Unfortunately
in the six and a half years since I was diagnosed, several BERNINA®

dealers and staff members have been diagnosed, one of my best
friends has been diagnosed, my neighbor across the street just lost
her battle with breast cancer, and my sister in law has just finished
chemo treatments. Every time I hear of another person being
diagnosed, it is like putting another pin in the pincushion. 

Listen to your body—all women should have yearly check ups
and conduct monthly self-exams. Support the agencies who are
conducting the research to stop breast cancer. Enjoy your lives—
most of our irritations are small annoyances in the big scheme of
things. We are all vulnerable but we all have the ability to react
positively and be proactive about our individual “bumps” in the
road. Enjoy your journey through life—realize we are never in
control—it is a very humbling realization—but you do have the
power to persevere and emerge as a real survivor! 

Since its formation in 1982, the Susan G.
Komen Foundation with its Affiliate Network 

has raised nearly $600 million for breast 
cancer research, education, screening and 

treatment. For more information, call 
1-800-I’M AWARE (1-800-462-9273) 

or visit www.komen.org. 

Have you ever wished to:

• See what your garment or project would look like before you 
embroidered it? 

• Have embroidery software that would remove the stitches
under an embroidery object when you placed it on top of     
another one? 

• Match the thread color of the on-screen design rendering to the 
brands and color numbers of the spools in your stash? 

• Change the color scheme of a design and have the software 
tell you what color changes you made and print a list of the 
new thread colors?

• Sew a garment but weren’t sure how the fabric would look after
being stitched into a garment? 

• Have software that was so easy to learn that it was actually fun 
to use? Yes, FUN!

Explorations embroidery software from OESD gives you all these
things and more! A project-based software that is icon-driven using
drag-and-drop features to put designs and lettering on garments
and projects. You can actually see changes occur on the screen as
you make or change your design decisions. Explorations is so
innovative that there is nothing else like it on the market.

Based on the .art file format, Explorations is powerful but easy to
use. Some comments from those that have seen it are “I’ve really

been afraid of software but I can do this!” and “I haven’t been
interested in embroidering for a long time but this software makes
me want to embroider again!” Getting started is easy – simply open
a project, drag-and-drop the article to be embroidered, then
drag-and-drop embroidery designs on the screen. Garments and
embroidery designs can be shown together in actual sizes, so if
you’ve had placement problems in the past you’ll find that
Explorations will solve them for you. Paper pattern pieces can be
scanned into the software, so that embroidery can be planned and
viewed before the fabric is ever cut. When design planning is
complete, Explorations will print your project, ready to be used as
a template. Garments or other “embroidery blanks” can be resized
as desired, along with embroidery patterns and special designs
called “cookie cutters”.
Cookie cutters are
special “empty” motifs
that have no stitches
assigned to them.
Automatically add pat-
tern fills as desired, or
turn the designs into
appliqué outlines. 

The software can also
be customized for the options that YOU want. Explorations can be
expanded to include a number of options:

• Buttonhole option • Appliqué option
• Reshape option • Mirror Merge option
• Circle, Star, and Ring • Machine Connection

option option
• Write to Commercial Formats • Quilter option 

option (.dst and .exp)

You decide what you want and purchase just those options. The fun
part is that you can buy these options anytime of the day or night
using your computer, as all options are purchased online at
www.embroideryonline.com and then downloaded to your
Explorations software whenever you want by clicking on the
Update button in your software.

BY MARTHA SHERIFF

See at your local dealer or see it online at www.embroideryonline.com
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Reprinted from The Fat Quarterly with permission of Benartex, Inc.

Meadowbrook Table Medallion

1359 Broadway ● Suite 1100 ● New York, NY 10018
212-840-3250 ● 800-236-2783 ● Fax 212-921-8204 ● info@benartex.com ● www.benartex.com

21⁄2˝ FINISHED

Supplies needed:
Fabric:

Diamonds—4˝ swatch pack 
(36 squares assorted fabrics)

Backing—18˝ square (or FQ)
Batting:18˝ square low-loft batting
Template: 5˝ x 5˝ piece of template plastic to 
make your own template or a 21⁄2 ,̋ 60 degree diamond
shaped template (available from Come Quilt With Me or Ardo)

Trace diamond template from this pattern onto the template
plastic and cut it out. Remember to transfer the markings 
for seam allowances and straight of grain onto your 
template.

Step 1—Center Star: Arrange 6 fabric diamonds 
to form a star with the long point of each 
diamond meeting at the center of the star. 
This six-pointed star is the middle of the 
medallion. take time to arrange the diamonds 
in a pleasing color arrangement.

Step 2—Row 2: Arrange 12 more 
diamonds to make a second row 
around the center star.

Step 3—Row 3: Arrange 
the remaining fabric 
diamonds to make a 
third and final row.

Step 4—Separate the 
medallion into 6 groups 
of 6 diamonds as shown. 
Each group contains one 
diamond from the Center Star, 
two from Row 2 and three from Row 3. Together they form
a pie-shaped wedge of the medallion.

Step 5—The pieces are labeled numbers 1-6 in the diagram.
Sew pieces 1, 2 and 3 together to form a row. Press all seams
in one direction. Sew pieces 4 and 5 together to form a row.
Press all of these seams in the other direction. Sew these two 

rows together matching seams. Sew 
piece 6 to the second row as 
shown. Do this for each of 
the six groups of 6 diamonds.

Step 6—Sew three 
groups together to form 
each half of the 
medallion. Sew halves 
together. Press.

Step 7—Layer backing 
(wrong side up), batting 

and medallion (right 
side up). Pin baste and 

quilt as desired. Trim 
away the extra backing 

fabric and batting to match 
the star points on the third 

row of the medallion. Blanket 
stitch around outside edge of 

medallion by hand or machine.

Step 4

Step 5

Step 6

by Gayle Camargo
Add a colorful touch to your table 

with this charming medallion 
pattern. A great way to use up 
scraps or fabric squares. For a 

wallhanging, just continue 
adding rows until you 

reach your desired size.



Black Rose 
Blouse
Our lives are filled with occasions that call for special garments that rise above the ordinary, but who
has time to make them? In the sewing room, as in the kitchen, not everything we make needs to start
from scratch. Occasionally we need a project that takes less time and planning, but that still provides
the opportunity to exercise our creativity. Purchased garments afford us the ability to customize an
outfit without taking a lot of time out of our busy schedules. Linen blouses provide the perfect
canvas for orchestrating customized details. 

Working with black thread on brown linen creates a strong contrast and a striking appearance, while
a matching color would create a subtle tone-on-tone effect. The embroidered rose is from the Studio
BERNINA Austrian Laces embroidery collection. Use Isacord embroidery thread in the needle, and
stabilize the stitching area with Ultra Clean and Tear stabilizer. 

A corded entredeux stitch edges the collar and sleeves and is created
using fine embroidery thread, a Wing Needle, perle cotton cord, Cording
Foot #25 and the Patchwork Seam Guide. Select the entredeux stitch and
adjust the Stitch Length to 2.8mm and Stitch Width to 3mm. Thread the

bobbin and Wing Needle with lightweight cot-
ton embroidery thread. To incorporate the cord
into the entredeux stitch, open the small black
latch at the front of the foot and place lengths of
cord through the second and fourth grooves; close latch. The cords will
automatically be placed close to the wing needle where they will be
enclosed in the entredeux stitching. allowing the cords to run closely to the
Wing Needle and be easily incorporated into the stitch. For accurate
placement, attach the Patchwork Seam Guide to the arm or the machine,
then adjust to align with the edge being finsihed. At ends, bring thread
tails to the back of the work and tie into knots before clipping.

Insert a Universal needle and thread with Isacord or construction thread.
Attach purchased black lace to the shirt hem using Leather Roller Foot
#55, the perfect accessory for stitching along a curved line. For lace trims
with straight headers, use Piping Foot #38 to stitch the lace to the hem;
the cut-out under the sole easily accommodates the uneven layers.

BASIC SUPPLIES:

• Sewing machine

• Purchased Linen Shirt

• Embroidery machine

• Desired lace embroidery 
designs or collections

• Wing needle, size 100/16

• Embroidery needle, 
size 70/10 or 75/11

• Universal needle, 
size 80/12 or 90/14

• Ultra Clean and Tear Stabilizer

• Non-permanent fabric marker 
or fabric pencil

• Isacord embroidery thread

• Fine embroidery thread or 
heirloom thread (60 or 80 
weight cotton)

• Perle cotton cord, size 8 in 
matching or contrasting color

• Purchased lace for hem

• Leather Roller Foot #55

• Cording Foot #25

• Patchwork Seam Guide

• Piping Foot #38 (optional)

• Recommended Reading: 
Fine Machine Sewing by 
Carol Laflin Ahles

I S S U E  8
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BY SUSAN FEARS
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BY CARRIE GORR & JO LEICHTE

A WHOLE NEW CRAFT
The art of preserving memories has come a long way since the
days of photo albums with black pages and little black photo
corners. Today scrapbooking has become a national pastime,
with specialized shops and craft stores in little towns and big
cities stocking a bewildering array of papers, stickers, writing
implements, die-cut shapes, and much, much more. Did you
know that your sewing machine can also be used in
scrapbooking? Decorative stitches, threads, and odds & ends
from your sewing basket add elements that provide interest
and identify pages as uniquely your own. 

THE RIGHT PHOTOS
It’s easy to get carried away when taking vacation photos,
then realize after developing the film that one has 120 pho-
tos of the hotel, but none of the people you met or places you
visited. Make it a habit to take at least one “people” photo
and one “place” photo everywhere you go. In addition,
experienced scrapbookers know that along with to photos,
souvenirs such as postcards, ticket stubs, maps and
menus add variety to a page design.

Mismatched buttons, raw edges, cotton tape, and a slight tilt to the photo

create an informal look on the page above, just the feeling wanted for a

relaxing vacation in the mountains. Page design by Jo Leichte



SECURELY STITCHED
One of the easiest applications for stitches is securing photos and
other elements to the page. Experiment with a variety of stitches and
threads on scraps of paper and photos to find the ones that are the
most   appealing for a particular theme. Zigzag, honeycomb, and
feather stitches are available on most sewing machines; if you
machine has lots of decorative stitches, this is a great place to use
them. It’s also quite easy to “frame” a photo with ribbon or other flat
trims. Place the ribbon over the edges of the photo, folding or over-
lapping at the corners. Beginners may want to secure the trim in
place with a bit of glue stick before stitching. Corners can be left
plain, or embellished with a button (also sewn by machine!).
Buttons are also great for securing small items to the page, or
used simply as decorative elements on a page. Check out the
supply of novelty buttons at your local sewing stores – they
often have the best button selection in town.

PAPER STITCHING TIPS:
When stitching on paper use a longer stitch length than
normal. Short, tiny stitches will cause the paper to
“perforate” and pull apart. 

Be aware of the texture and composition of the paper you select. If it has
natural elements such as leaves, twigs, etc., stitch around these as much as possible to
avoid breaking needles.

Stitching paper will dull machine
needles so keep these separate from
other needles and use them only for
paper stitching. Note: Bent or burred
needles will not stitch any better on
paper than they do on fabric. They
cause skipped stitches and patterns
that don’t form properly; they can also
cause damage to your machine so
discard any when you discover them.

I S S U E  8
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The “View the World” flyer from an
architectural tour of the Sears Tower in
Chicago set the tone for the design of
these two pages (to the left). “Blueprint”
paper, yellow cardstock, and variegated
blue and yellow thread echo the colors
of the flyer, and decorative stitches
mimic the shape of a city skyline. Page
design by Carrie Gorr

The miniature map of Wisconsin on the postcard and the boat tour ticket stub add
color and contrast to this page, while the wavy blue decorative stitches and paper
contribute to the “watery” atmosphere. Page design by Carrie Gorr



inny Affleck, Pati Beck, Joann Laub, and I, all
members of the Dixie Quilt Guild in St.
George, UT, worked almost 300 hours over

three months to make the quilt, "The Friend Ship", for
entry in the BERNINA® of America Quilt Guilds for
Charity Contest. It turned out to be well worth the time
because our quilt won top honors and each of us
received a trip to Houston, TX for the IQF Quilt Show
this fall.

The theme for the contest was "Friendship" and the
winning quilt was to be displayed at the BERNINA®

booth during the 2003 Houston International Quilt
Festival in October. Quilts were judged by BERNINA® of
America, then forwarded to the guild's chosen charity.
After much consideration, we selected YouthLINC
(youthlinc@earthlink.net) to receive our quilt.

YouthLINC enables Utah students to participate three
international service programs: a school for the deaf in Kenya,
Africa; a school for the disabled in Mexico; and a school in the
rainforests of Peru. Students must complete service locally to
receive a scholarship, which pays for part of their trip. Professors,
doctors, and other professionals accompany the students on the
two-week trips. YouthLINC raises money to cover trip expenses
through fundraisers, so they were happy to accept our quilt for
their upcoming needs.

We were able to speed the process of making the quilt by using
a quilt background that I had made in a winter class at Whimsy
Cottage in Heber City. The class focused on story quilts and was
taught by international quilting teacher, Mary Lou Weidman.
Weidman, who started her design career doing paintings, was
used to having a canvas in front of her. She would fill in the
background color and then go back and fill in the rest of the
colors in her subjects. She taught us her technique for making
the entire quilt background first, borders and all.

With our quilt "canvas" ready to go, it was time for us to decide on
a design. We started by collecting quotes pertaining to friendship
and brainstorming ideas for designs to interpret the quotes. After
a long evening of idea sharing, we settled on this quote: "There
are big ships and small ships, but there are no ships like

friendships." There would be three intrepid sailors (representing
YouthLINC's three international programs) in a homemade
sailboat navigating life's stormy seas. A seasick kitty, a happy
puppy, and lots of fish in the swirling waves would complete the
scene.

Pati Beck drew the design for the quilt and then we started
"auditioning" fabrics for the various components. Once all the
pieces were cut, we appliquéd them to the background using a
machine appliqué technique developed by award-winning quilter
Sharon Schamber of Jensen, Utah. Schamber taught her
technique at the Dixie Quilt Guild's annual Zion Retreat in 2002.

Other Dixie Quilt Guild members were instrumental in
completion of the quilt. Margaret Miller expertly machine quilted
the top using threads donated by Heather Purcell of Superior
Threads. Quilted into the background are octopus, starfish,
waves, clouds, and many other fun designs. Cory Allender
bound the edges of the quilt and attached a hanging sleeve so
that the quilt can be easily displayed.

Editor: The two quilts that won Honorable Mentions in the contest
are very different from the winning quilt in style but were made
with just as much enthusiasm and desire to help.
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BY ANNIE UNREIN

G
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Name of Quilt: Hearts for the Cure
Quilt Guild: Miss Stephanie's Finishing School 

Couer d’ alene, ID
Made by: Dawn Forest
Donated to: Susan G Komen Foundation

Name of Quilt: A Lifetime of Friends
Quilt Guild: The Friendship Stitchers

Brecksville, OH
Made by: Dianne Young & Fran Salley
Donated to: Habitat for Humanity

Honorable Mention Winners



BY JO LEICHTE

Notice that the seam between the brim and crown of the hat is nearly 
the same shape as the curvature at the lower edge of the Large 
Oval Hoop. When planning your text, use the lower edge of the 
on-screen hoop as your guide. 

The sample has two lines of text – “Through the” and 
“Needle”. Both were programmed separately, using the 
Blackboard alphabet, and moved to the lower edge of 
the hoop. After programming the text, select the third 
U-shaped lettering option – the artista 200E automatically 
curves the lettering into a shallow “U” shape. Adjust the 
size and spacing of letters as desired. 

When all adjustments have been made to the design, 
retrieve all the elements and move them to the center of 
the hoop. Select OK to process the stitching. Follow the 
directions included with the Hoop ‘N’ Buddyz Hat Hoop 
Insert to position the lettering on the crown of the hat. Be 
careful to position embroidery so as not to stitch through 
the brim seam or metal grommets.

Embroider hat as directed in Hat Hoop Insert instructions.
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Question: How can I make the lettering on my hat
curve like the inside edge of the brim? 

Answer: Use the Word Art features of the artista 200E
to curve lettering as described below. 



Create professional-looking coverstitched hems – it’s easy!

Designed to work with the cover stitch, the Coverstitch Foot (also called
the Compensating Foot) has two “floating toes”, one on each side of the
foot. The “floating toes” help guide the fabric under the foot and prevent
sideways motion when stitching hems and seams. 

The new Coverstitch Hem Guide is engineered to guide and position
the hem so that the stitching is positioned an even distance from the
fold, and the raw edge is captured within the looper stitches of the
coverstitching. Used in conjunction with the Coverstitch Foot, the new
Hem Guide guarantees perfect, professional-looking hems.

TIP: Create decorative hems using heavier threads such as Mettler
30 weight cotton embroidery thread or YLI Jeans Stitch (shown
in the photos) – both are available in a wide range of colors,
including variegated colorways.

• Set serger for wide or narrow coverstitch as desired, using the
Coverstitch foot. 

• Fold hem to the wrong side; press in place. Trim hem
allowance to desired depth, between 5/8” to 1”.

• Attach the Coverstitch Hem Guide to serger using the two
attachment screws. Loosen adjusting screw and adjust the
depth of the guide to match the folded hem; tighten screw.

• With the right side of the garment facing up, place the hem
under the presser foot and guide the hem allowance into the
guide so that the fold is against the right side of the guide
(1), the hem allowance wraps around the “shelf” of the guide
(2), and the raw edge is against the left side of the guide (3).
BERNINA®’s exclusive Coverstitch Hem Guide is for use
with BERNINA® serger models 2000DCE, 2500DCE,
2500DCET, 1300DC, and Funlock 009DCC. 

• Stitch hem, guiding folded edge into the attachment.

Coverstitch Foot & 
NEW! Coverstitch 
Hem Guide

I S S U E  8
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Place folded hem 
into the guide.

4 thread 
coverstitch

Narrow
3 thread 
coverstitch

Wide
3 thread 

coverstitch

Attach hem guide 
to bed of serger.

1

2

3
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BY MARLEE CARTER
Cote Bros. Sewing Machines, Auburn, ME

When the Fantastic Felines embroidery collection
came out, I just knew I had to make a vest. When

trying to decide on fabric and looking through my stash I
realized that I had one piece of silk noil that I had dyed and

it was just the right color to go with all those cats. 

CURVED PATCHWORK PATTERN
Lay out the pieces of your vest pattern, aligning the side

seams. Trace the entire vest outline onto tracing paper to create
a master pattern for planning your garment. Draw gentle curves

to break the vest into smaller pieces, keeping in mind where each
embroidered cat will be. Keep the size of the sections in scale with
the embroidered cats.

When you are satisfied with the shapes and arrangement, TURN
THE TRACING OVER. Number or letter each section. Mark each
section that will have an embroidered cat. Draw 2-3 registration
marks across each seam in several places. 

Place a sheet of freezer paper (paper side up) over the tracing.
With a permanent maker, trace each section, including numbers
and registration marks. Cut the pieces apart along the drawn lines.
Iron each piece to the WRONG side of your fabric. Using a small
rotary cutter, cut just outside the lines on the freezer paper, leaving
about a 1/8” seam allowance. Transfer registration marks from the
freezer paper to the seam allowance of the fabric. Place each
piece into position on the master pattern. Continue until all pieces
are cut. 

• Studio BERNINA® Fantastic Felines 
embroidery collection by Laurel Burch

• Assorted Isacord embroidery threads

• Patchwork Foot #37 or
Straight Stitch Foot #13

• Your favorite vest pattern

• Fabrics as required by pattern 
(sample uses hand-dyed silk noil)

• Fabric for embroidery (sample 
uses white/cream silk noil)

• 8-10 black & white prints 

• Tracing paper

• Freezer paper

• Fine permanent black marker 

• Paper scissors

• Small (18mm) rotary cutter and mat

• Wash-away fabric marker
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EMBROIDERY
Stitch 6 to 8 embroidery designs on white/cream silk noil as desired.

BLACK & WHITE CURVES
The black and white banded curves are sewn with the stitch and flip method, using the
freezer paper pattern piece as a base. Set machine for a straight stitch with a length of 2mm
(the short stitch length makes it easier to remove the freezer paper later). Starting at the
narrowest end, place two pieces of fabric right sides together (RST) and sew to the paper
side of the freezer paper along the very edge of the pattern piece. Trim seam allowance
to approximately 1/8”. “Flip” fabric and press open. Continue in this manner,
placing the next fabric RST and stitching on the paper side. Press each piece as
it is added for a nice, smooth curve. Do not pay too much attention to the sides
of the curve while creating the band; when piecing is complete, trim seam
allowances to approximately 1/8”.

CURVED PATCHWORK PIECING
Position all curved patchwork pieces on the master   pattern. Pick up two
adjacent pieces. Remove freezer paper, then place fabrics RST and sew
using a narrow 1/8” seam allowance. This is easier to do if you DO NOT use
pins. Engage the Needle Stop Down function of your machine. Begin by lining up the
beginning of the seam and taking just a few stitches. Continue stitching the seam, holding the
top fabric in your left hand and guiding the lower fabric with your right hand, aligning the edges and
registration marks as you sew. Do not pull – just gently place the top fabric over the lower   fabric. Press
seams to one side. Continue until all pieces are sewn together. 

VEST CONSTRUCTION
Place the master pattern over the patchwork and trim fabric as needed. Use the completed patchwork piece as a pattern for cutting the lining. 

Sew lining to vest along all edges except shoulder seams. Trim and grade seams, then turn vest right side out through one of the shoulder
seams. Place patchwork shoulder seams RST; sew, extending stitching past patchwork/lining seams approximately 1/2” on each end of the
seam. Turn under seam allowance of lining; finish seam by hand. 
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“Fantasy” is the theme of the 2003
BERNINA® Fashion Show and 49

designers interpreted this in the
most interesting, imaginative ways possible.

From quilting to embroidery to appliqué and beyond, the
techniques featured on these garments will challenge your ideas
of what can be done with fabric, needle, and thread. The 2003

BERNINA® Fashion Show debuted at the International Quilt Festival in
Houston, Texas. Here’s a peek at some of the amazing garments that

came down the runway. All of the garments are showcased in the 2003
edition of Fashion & Imagination, available at your local BERNINA® dealer,

Barnes & Noble Bookstore, and other magazine outlets. In addition to
wonderful photos of these inventive garments, vivid descriptions – written by the

talented Susan Voigt-Reising – bring the garments to life, detailing the creation of
each wearable work of art and the imaginative use of materials and techniques. 

After its debut at Quilt Festival, the BERNINA® Fashion Show travels to select
venues, including two international quilt shows: the Patchwork and Quilt Expo in
The Hague, Netherlands, and the Creative Sewing & Needlework Festival in
Toronto, Ontario, Canada. If you’re lucky enough to be near one of the places the
show will appear, plan to attend to see the garments up close and personal – you’ll

be inspired to create your own fantasy!

BY JO LEICHTE

“Heian Harmony”
by June Colburn
(also shown on cover)

“Queens Are
Wild” by 
Cynthia D.
Friedman

“The Incredible 
Lightness of Being” 
by Ellyn Mosbarger

®
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The 2003 BERNINA® Fashion Show: Fantasy

TRAVEL SCHEDULE
JANUARY 25 – FEBRUARY 1, 2003

Phoenix, AZ: Quilting in the Desert

FEBRUARY 26 – 29, 2004
Puyallup, WA: Sewing & Stitchery Expo

MARCH 26 – 28, 2004
Chicago International Quilt Festival

APRIL 16 – 18, 2004
Toronto, Ontario, Canada:
Creative Sewing & Needlework Festival

APRIL 29 – MAY 2, 2004
The Hague, Netherlands: Patchwork & Quilt Expo

MAY 20 – 23, 2004
Pittsburgh, PA: International Quilt Market

JUNE 23 – 27, 2004
Atlanta, GA: BERNINA University (BERNINA® Dealers only)

“Majestic 
Geometric 
Melody”
by Priscilla 
Stultz

Charlotte Warr Andersen - Salt Lake City, Utah
Charlotte teaches internationally, encouraging her students to
“draw out their own visions and creativity.” She specializes in
one-of-a-kind pictorial quilts and has authored two appliqué
books featuring the unique layering techniques she employs to
obtain dimensional, life-like images. Her quilts have won an array
of prestigious awards, including two Best of Shows at the
Houston International Quilt Festival. Wearable art is another of
Charlotte’s passions, a pursuit which has led her to eight
Fairfield/BERNINA® fashion shows. She dedicates this year’s
creation to her mother, Marty Warr, who taught her to sew. Mary
died April 25, 2003, just as Charlotte was beginning her garment.

Jennifer Stern - Manchester, Connecticut
Jennifer credits working with a talented group of women at
Manchester Sewing Machine Center in 1997 with invigorating her
interest in sewing and developing her creative spirit. She quickly
focused her energy on exploring the possibilities afforded by
digitizing software and began creating original embroidery. “I’m

always developing ways to achieve different effects with threads,
stabilizers and fabrics,” says Jennifer. “I also love to combine
my original embroidery with traditional quilting techniques in
unconventional ways.” Jennifer’s gowns featuring her original
embroidery have won several awards. She tests embroidery designs
for Threads magazine and regularly teaches sewing classes.

Frances Krupka - Traverse City, Michigan
Frances has been making clothing for herself and family for more
than 40 years, thanks to skills taught by her mother and grand-
mother. Fran caught the quilting bug in the ‘80s and discovered
wearable art soon after. Her original patchwork designs, sold as
Franceska Creations, have been juried in IQA shows. Her most
recent penchant is recycling rescued neckties into unique pieces
of art. The year 2002 was an exciting one for Fran. In addition
to the publications of Tied Up!, a book of necktie designs, it
included a daughter’s wedding and two prestigious quilting
awards. This year is proving to be just as busy, highlighted by a
move from London to Michigan’s wine country.

Winning 
Fashion Show

garments pictured 
on Page 22

®
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The Viewer’s Choice 
Award 

“Black Tie Affair” 
by Frances Krupka 

Winner of a BERNINA®

virtuosa 153 Quilter’s 
Edition sewing 

machine.

The Judge’s Choice 
Award 

“Floral Fantasia” 
by Jennifer Stern 

Winner of a 
BERNINA® activa 135S 

Patchwork Edition 
sewing machine

The Créme de la Créme 
Award 

“Josephine’s Amazing 
Neutral-Colored

Dreamcoat”
by Charlotte Warr 

Andersen 

Winner of a 
BERNINA® artista 200E 

embroidery system.



The beauty of rows of flowers in a garden can only be
equaled by rows of patchwork designs uniquely combined
to create colorful quilts. Karin Hellaby developed a creative

approach to quickly and easily make quilts based on a “magic”
formula that lets you create your own unique quilt with fast and
accurate patchwork. When asked what inspired her to create
quilts by rows, Karin says, “As a textiles teacher I have always felt
that teaching students techniques eventually gives them the
confidence to create their own individual quilts. I felt row quilts
would enable sewers to try patchwork while giving them a
very simple formula to incorporate the patchwork into their
own design quilts.”

The advantage of the row concept – stitching patchwork blocks,
joining the blocks to make a rows, and then sewing the rows into
a quilt top – can be understood by everyone. Karin’s first book,
Sew a Row Quilts, is a resource that takes students through
dozens of techniques, all of which can be sewn into 4" and/or 8"
blocks. Each technique is described in a simple, quick, and
efficient way. “The choice of block size is made by the stitcher”,
Karin says. “All one has to remember is that two 4" blocks equate
to one 8" block. The quilt variations are tremendous as there are
so many choices, and formulas are given for numbers of blocks
and rows needed to make standard-sized quilts from crib to king
size.”

A great text for all skill levels, Sew a Row Quilts is arranged to
start with skills needed by beginning piecers, and moves
students through to an advanced level and total addiction to this
absorbing craft. According to Karin, “Many have used the book
to teach themselves. I have been shown quilts that have been
made in two weeks by sewers who have never tried patchwork
and quilting before. Quick success like this is a great start and
keeps them coming back for more fabric, projects and more
sophisticated machines. Experienced quilters use the book as a
reference tool; many have never before tried techniques such as
migrating geese and using quilting stencils for bias, reverse
appliqué and Italian corded quilting work.”

Karin’s latest book, Sew a Row Projects was launched in
September of this year. She has designed some unique patterns
utilizing multi-technique Sew a Row quilt techniques. Although
this project book refers to techniques in Sew a Row Quilts,
there are many new ideas, such as a great new way of putting
together reversible quilts using a sew and flip method. Ideas for
making funky folders and tote bags are given with many inspiring
examples. This is a project book with a difference, with
suggestions for many variations and adaptations encouraging
readers to use these projects as a jumping off point for their own
unique creations.

BY SUSAN BECK
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Owner of Quilters Haven, a
sewing center and   fabric shop
in Suffolk, England, Karin won
the Michael Kile Scholarship –
International Retailer of the
Year – from Quilts, Inc. in

1998. She has written and self-published three books –
Sew a Row Quilts, Magic Pillows, Hidden Quilts, and Sew a
Row Projects – and teaches classes at quilting events
around the world.

KARIN 
HELLABY
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BY KAY LYNCH

NOTE: The design shown on the hanger is
available on the artista 200 CD and the
artista 165-185 card formats only. For other
machines, combine alternate designs and
hoop separately if needed.

PREPARE WOODEN PLAQUE:
• Lightly sand the 9” x 12” wooden plague if
needed and wipe to remove any dust.

• Apply a thick layer of ivory acrylic paint
and allow it to dry. (This will be the color of
the “cracks”.)  

• Apply the crackle medium and allow the
crackle medium to dry until tacky. (Refer to
manufacturer’s instructions for details.)

• Apply a white layer of paint over the crackle.
The cracks will begin to appear in just a few
minutes. Allow it to dry completely.

• Spray the entire piece with a paint sealant spray
and allow it to dry thoroughtly.

EMBROIDERY INSTRUCTIONS:
• Spray two layers of OESD Heavy Weight
Cut-Away Stabilizer together with temporary
adhesive spray.

• Spray the top of the two stabilizers and adhere
to the wrong side of the rectangle of fabric.

• Hoop the three layers as one and attach the
hoop to the machine.

• Stitch the welcome sign design.  NOTE:  It is
absolutely necessary to clip thread tails and
jumps between each color change for cross stitch
designs to prevent thread traps.

• Remove hoop from the machine and the fabric
from the hoop.  Do not remove the stabilizer from
the back of the project.  

• Trim the embroidered rectangle to 4” x 9”
keeping the design centered.

• Zigzag or serge around the outside edges of
the rectangle.

ASSEMBLE THE PROJECT:
• Place the batting rectangles 13/4” from the top
and the sides of the painted wooden plaque.

• Glue the batting in place with a small amount of
glue from the hot glue gun.  Add a small amount
of glue between each of the layers of batting to
secure in place.

• Center the embroidered rectangle over the
batting.

• Secure the edges of the
embroidered rectangle in
place. Use a wooden chop-
stick to “flatten” the edges
after gluing.  

• Continue until all edges are
glued in place.

• Glue the pink tape in place
on top of the zigzag stitching
or serging around all four
sides of the embroidered
rectangle.

• Glue the yellow tape in
place, and then the green
tape.

• Space the hooks evenly across the lower edge
of the plaque and tap into place.

• Attach the picture hanger to the back of the project.

• Hang keys or small sewing gadgets from the
hooks.

SUPPLIES:
• Designs from OESD 

Licensed Design 
Collection 778 “Everyday 
Treasure by Diane 
Arthurs” available in the 
following formats: artista 
200 cd/artista 165-185 
card/Babylock, Brother, 
Deco, and compatitbles 
card / Viking Rose, Viking 
Iris, Viking 1+

• Isacord Polyester 
Embroidery Thread

• OESD Bobbin Thread

• OESD Heavy Weight 
Cut-Away Stabilizer

• Temporary Spray 
Adhesive

• 9” x 12” Rectangle white 
Fabric for Embroidery

• Three Rectangles of 
Batting cut 4” by 9”

• 9” x 12” Wooden Plaque

• Ivory and White Acrylic 
Paint 

• Crackle Medium

• Wood Spray Sealant

• Hot Glue Gun

• 4 Push Pin Hangers

• 1 Picture Frame Hanger

• Three 1/4” Wide Tape 
Measures in desired 
colors by Nifty Notions

• Wooden Chopsticks



WANT TO LEARN MORE?
For more Stitch Recipes, visit the Sewing Studio at: www.berninausa.com

Cook up a new 
recipe for embellishment 

using the decorative 
stitches of your BERNINA®

sewing machine. 
Try new combinations, 

different directions, 
overlapping patterns, 
and unusual thread 

choices to get beautiful 
embroidery looks using 

decorative stitches. 

Sew many stitches, 
sew little time...

Begin by planning your row spacing. The rows in the sample are approximately 1/2”apart, with 9mm wide stitches. If your stitches are 5mm wide, you may want to placeyour rows closer together. 

Choose thread according to the desired final appearance: for a matte finish use cottonthreads such as the red 30 wt. cotton and subtly variegated blue Oliver Twist shown inthe sample; for a shiny finish use 30 wt rayon or polyester embroidery threads. 

Needle – Use a size 90/14 machine embroidery needle.

Create the following stitch combination using the MEMORY feature of your machine:
Stitch 906 (star) Default setting (Note: Numbers listed are
Stitch 417 (satin chevron) Default setting artista stitch numbers,
Stitch 906 (star) Mirror Image look for similar stitches
Stitch 417 (satin chevron) Mirror Image on your machine.)

Save this combination. Using blue thread, stitch every other line, staggering thestarting point of each row to create more visual interest. 

To create the red stripes, select Stitch 414 (satin wave). If your machine has a PatternExtend feature, lengthen the pattern to your personal liking. Stitch every other row(between the blue stripes), again staggering the starting point of each row.

Stars & Stripes

Show your patriotic spirit with a
fun and simple stitch recipe!
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SUPPLIES

• BERNINA® artista Designer Plus version 4.0 

• artista 200E 

• Mega Hoop*

• Embroidery design collections of your choice**

• Embroidery thread

• Temporary fabric adhesive

• Poly Mesh stabilizer

• Aqua Film water-soluble stabilizer

• Organ needles for embroidery 

• Small, sharp scissors for trimming appliqués

• Size 80/12 Universal or Sharp needles for 
construction and quilting

• Patchwork Foot #37 (1/4” foot)

• Walking Foot #50

• Freemotion Quilting Foot #29/29C

• Bias Binder Attachment #84 and Foot #94 

• 1 packet Bead Soup to coordinate with quilt

• 1 packet QRI Designer Threads “Frieze” to 
coordinate with quilt

• Monofilament thread

• Stencil burner

• Polyester organza

• Quilt fabrics (100% cotton)

• Batting

BY JENNIFER GIGAS

uilting and embroidery worlds collide
in this quilt. Utilizing a number of new

features found in the V4 BERNINA® Embroidery
Software along with the power of the artista
200E sewing and embroidery system, this quilt
offers a taste of sewing technology. The
BERNINA® Quilter program was used to plan
this quilt, then a touch of this and a pinch of that
were added – still using the Quilter program – to
achieve just the right look.

The following is an overview of the techniques
used to create the featured quilt.You’ll notice that
there are some diversions from customary quilt-
ing and embroidery practices. For more detailed

information, consult the BERNINA® artista
software User Manuals and the artista 200E
Owners Manual.

QUILT TOP LAYOUT

Color combinations can be previewed without
wasting time or fabric sewing multiple test

blocks. Favorite combinations can be printed
and auditioned in various color-ways before
beginning a project.

• Select the desired layout – square or on-point
– including the number
and size of blocks.

• Select favorite blocks
and fabrics. (Featured
quilt uses Triangle 2
from the Diamonds
folder and the
Hibiscus block from
the Appliqué/Hawaiian
folder). For a medallion

QQ

*If embroidering appliqués using the 200E embroidery module, it is necessary
to use the Mega Hoop to accommodate the size of the appliqué pieces. You may opt
to attach the appliqués by sewing machine.

**Featured quilt combines designs from the Cutwork and Crewel embroidery collection
by Iris Lee, Sue Box Artistic Adornments CD, and Tassels & Trims II embroidery
collection by Louisa Meyer.
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block, as in the center of the sample, do
not select a block style. Instead, simply fill
with fabric.

• When layout is complete, print a shop-
ping list and construction information for
each block.

EMBROIDERED APPLIQUÉ
Embroider appliqués
with perfect tapers
and miters every
time. Using the new
Partial Appliqué tool,
appliqués with multi-
ple pieces are creat-
ed automatically.

• Scan each appliqué piece, then open
Designer Plus software and digitize each
shape. Select an appliqué object; open the
Object Properties Dialog box. Fine tune
the satin stitching and select the Trim In
Place option; this adds a stop after the
placement line is sewn, allowing excess
fabric to be trimmed before satin stitching
is sewn.

• Delete the graphics from the design file.
Save design. Send to embroidery
machine.

• Stitch appliques.The machine sews out a
placement line and then stops. Position
appliqué fabric, then restart the machine.
Tack down stitches are sewn; when
machine stops, carefully trim away excess
fabric. Restart machine and complete
applique stitching.

BLACKWORK ACCENT FABRIC
The small triangles
surrounding the center
block are pieced with
base fabric that has
been stitched with
Blackwork fill to add
texture, color and
dimension.

• Select the largest hoop available for
stitching blackwork accent fabric.

• Select the Rectangle tool, Blackwork fill
(found in the Craft Stitch toolbar), and
digitize a rectangle that covers the entire

stitching area within the hoop.

• Select the rectangle, open Object
Properties, then select a Blackwork fill,
altering layout if desired.

• Save file; send the design to your
embroidery machine. Stitch.

At this point, the top of the sample quilt was
pieced, then spray basted to the batting (do
not attach backing at this time). The center
block was channel quilted using Walking Foot
#50 and the quilters securing stitch (#324) on
the artista 200. Note: While the center
medallion embroidery could have been
completed prior to construction, channel
quilting the central block first eliminates the
need to stop and start stitching to avoid
sewing over/through the medallion.

EMBROIDERED CENTER  
MEDALLION

• Create a square the size of the center
using the Rectangle tool and a Single out-
line stitch.

• Insert a floral element; while selected,
select the Wreath tool, six spokes. Position
duplicates in a pleasing arrangement.
Note: Do not let the spokes overlap, as the
resulting wreath is larger than the hoop
and will need to be split.

• Print a template; save design.

• Delete the square. Select the Mega hoop
and Manual Centering. Select and delete
half of the wreath. Save as “wreath 1”.

• Select Undo. Select other half of wreath
and Delete. Save as “wreath 2”.

• Print templates to aid in positioning
embroidery.

• Embroider center block.

EMBROIDERED CORNER 
SQUARES

• Create a square the
size of the corner block
using the Rectangle tool
and a Single outline
stitch.

• Insert a cutwork
design. Select the

Closed Curve tool and Lace fill from the
Craft Stitch toolbar. (Hint: Select a color
that is not in the cutwork design.) Digitize
around the large open areas in the cutwork
design.

• Select Color Film and drag the lace to the
beginning of the stitch sequence.

• Select everything except the square,
select Mirror Merge Horizontal/Vertical.

• If block is larger than the hoop, split as for
the central medallion.

• Print templates. Stitch corner blocks.

FREE-STANDING APPLIQUÉ
The center of each corner square is
embellished with an embroidered appliqué
held in place with beads.

• For filled designs, hoop two layers of
Poly Mesh.Embroider, then burn away sta-
bilizer around outer edges. Set aside.

• For open designs, hoop polyester
organza with 2-3 layers of Aqua Film.
Embroider, then burn away stabilizer
around embroidery. Set aside.

DECORATIVE QUILTING

Included with BERNINA® Quilter is a folder of
beautiful quilting motifs by Holice Turnbow.

• Hoop a layer of Aqua Film; spray with
temporary fabric adhesive. Place quilt
top/batting over hoop; finger press in
place.

• Embroider. When complete, trim excess
stabilizer from around embroidery.

UTILITY QUILTING 
• Spray baste backing fabric to batting.

• Using Walking Foot #50, stitch-in-the-
ditch between blocks. Using Freemotion
Quilting Foot #29/29C, stipple quilt corner
blocks and echo quilt around appliqués.

• Tack embroidered appliqués in place with
beads and bind.

FINISHING
• Hand tack embroidered appliqués in
place with beads.

• Hand-sew beads at intersections of
channel quilting around center medallion.

• Bind quilt edges and add a sleeve for
hanging.

NOTE: All levels of BERNINA® artista
software include BERNINA® Quilter, but
only Designer Plus has the capability to
digitize embroidery objects. 



Professional
Profile
Professional
Profile Technical Educator, BERNINA® of America, Inc.

WHAT IS YOUR JOB?
I am currently a Technical Educator for BERNINA® of America, Inc. This 
involves putting together presentations and class materials for all our technical trainings as well 
as teaching them. Our department is also responsible for putting technical information on the 
dealer website. We also answer service phone calls on a daily basis.
HOW DID YOU ARRIVE AT YOUR CURRENT POSITION? I started working for BERNINA® in the Customer Service department. While I was there, my boss, 
Barb Kamper, decided it would be a good idea for me to take a Basic Technical course so that I 
would be more familiar with all the machines and their parts. While I was in class the instructors 
took note of my progress and ability and asked if I’d be interested in moving to the Technical 
Department to work as a technician. It was a tough decision as I enjoyed interacting with the dealers, 

but it was a tremendous opportunity to do something new and exciting. I never really knew that I
enjoyed taking things apart and fixing them until I took that first Basic Technical course, but as 
soon as I did my first adjustment I was hooked. Before I moved to the department, Hans Herzog, my
boss now, asked if I’d also be interested in teaching and helping with trainings. This was a new area 
for me but also a challenge to become familiar enough with the subject so I could teach it. I think it 
has all turned out for the best, and hopefully the dealers I teach feel the same way.WHAT DO YOU LIKE BEST ABOUT YOUR JOB? The thing I like most about my job is the interaction I have with our dealers. Whether in a classroom 

situation or answering a trouble-shooting question on the phone, it is nice to be able to provide 
information that is useful to dealers and technicians on a daily basis in their stores.DO YOU SEW? IF SO, WHAT IS YOUR FAVORITE THING TO STITCH? I was not a sewer before I came to BERNINA®, but I got hooked after I started working here. I love it 

now! My favorite thing to do is embroidery. It is so fun to see a design and imagine the different ways 

I can use it. I have just recently also taken up quilting and it has been a challenge, but also a lot of fun.ANY LAST THOUGHTS? 
I’d just like to say that I love the different things I do for BERNINA® everyday. I am involved in so many

different aspects of the Technical Department that are interesting and challenging. It’s a lot of fun to
come to work everyday and see what the next task will be.

SHASTA BURKE

Not everyone
who works in the
sewing industry
is a full-time
seamstress. 

From pattern 
designers to 
embroidery 
digitizers to 
notions buyers, 
it takes a 
multitude of 
skills to keep 
the industry 
moving. 

Meet people
with interesting
jobs and find out
how they got
there.
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The power to follow your inspiration.

Visit your Bernina Dealer and experience 
the new lightweight and powerful activa machines.
Introducing the new activa 145S and 135S Patchwork Edition. Both are

lightweight for easy portability and power-packed to penetrate the heaviest
of fabrics. With the attachable accessory case, all of your sewing tools can easily

follow you to kitchen to class to garden—wherever your inspiration blooms. 
Starting at just $999.*

No one supports the creative sewer like a Bernina Dealer • www.berninausa.com

*At participating dealers  •  ©2003 Bernina of America

Quilt by Alex Anderson




